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Introduction

This document assumesyouaref ami | i ar with the concept of wusability t
start with Usability Testing Basics which explains the basics of usability testing, including information about

how to figure out what to test, when to test, and how to test. Usability Testing Basics is available on the

Morae Resource CD and in the Morae Learning Center (http://www.techsmith.com/learn/morae/default.asp).

Hardware or Mobile Device Usability Testing with Morae

Are you building things people merely tolerateéor thin
or an espresso machine, you can improve the design by testing it in the hands of real customers.

Watch customers manipulate physical buttons and navigate on-screen menus. Capture their body language,
ver bal comment s, and success rates. Use Moraebs compl e

For a hardware or mobile device usability test, Morae can record from one or two cameras. With two cameras,
you can record close-up video of the hardware or device, along with camera video of the user.

This document provides the following:

B  Set Up the Test

# Record and Log Test Sessions

# Analyze and Present Findings

# How to Retrieve Your Key Measures from Morae

The document also contains the following appendices:

# Appendix A: User Research Request
# Appendix B: Test Protocol Document
# Appendix C: Example Usability Test Report
# Appendix D: Usability Test Checklist
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Hardware or Mobile Device Usability
Testing Considerations

Similar to software or Web usability testing, the goal of hardware or device testing is to measure the efficiency,
effectiveness, and satisfaction of the use of a hardware product or device by having users perform real-world
tasks with the product.

Because the device or hardware and the participanto6s i
camera, consider carefully what cameras, lighting, camera locations, and mounting hardware are needed to
record the activity.

Because screen recording data will not be available, prepare your markers carefully to ensure that observers
or the person logging on the recording computer will note events such as:

Task start and end times

#  The actions the participant takes (buttons clicked, menu items chosen)
#  When a mistake or error is made

# Comments and quotes of the participants

#  Observations of facial expressions and body language, etc.
Procedure

The test must be conducted in your lab (which can be as simple as a room with a computer and Web cam) or
face-to-face at an off-site location. These tests cannot be conducted remotely using UserVue because the
participant will be working directly with an artifact (hardware or a device), similar to paper prototype testing.

Also like paper-pr ot ot ype testing, the device or hardwaare and t |
recorded using a camera. A second camera caWebemnsim be u:
Picture-in-Picture.

Use the default configuration provided for paper prototype testing in Morae to record the test. Because there
will be no screen recording used, the recording computer can also be used to log test data during the test by
the facilitator or an assistant; consider having the facilitator log the test on the recording computer. Remember
you may need to flip your camera while recording to make the prototype view properly in the recording.
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Set Up the Test

Use the steps in this section to to set up the test in Morae Recorder. For more information on usability test
planning, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning

Center
Morae
Recorder

1. Create a Study Configuration
2. Define the Scenario

. Define Tasks

. Define Markers

. Define Surveys

. Save Study Details

. Configure Recording Details
. Complete Test Set Up

To set up a test in Recorder:

N O |Jo | W

A’ This document walks through this process at a high level. You can find more information on the full
procedures and options in the help included in the Morae components or find both video and written
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.

1. Create a Study Configuration

A study is a group of test sessions where participants complete the same tasks. In Morae, a study
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and
surveys.

You use the same study configuration to record each of the test sessions. Only recordings with the same
study configuration can be later searched and graphed together in Morae Manager.

Morae Recorder includes template study configurations to help you define study configurations for different
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured
Recording Details which define how to record the session.
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When you open Recorder, create a new study configuration based on Hardware or Mobile Device Study.
When you click OK, the template study configuration opens in Recorder.

Welcome to Morae Recorder

Ta record, you must create or open a study configuration,
Study configuration

The study configuration defines the markers, tasks, and surveys
for your study.

D (%) Create a new study configuration based on:

ardware or Mobile Device Stud v

Default Study

Focus Group \
Hardware or Maobile Device Stud ;
Paper Prototype Study

== Software or Web Usability Study

L: (OlUnmoderated Usability Study

2. Define the Scenario

A scenario gives the participant the background to complete the tasks. It tells them why they are doing the
tasks and any introductory information they may need to complete the task.

The scenario should be realistic and allow the participant to relate to the situation. For more on how to create
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning
Center.

For example, to find out how users interact with your company web site, the scenario may be:
You will perform up to 4 different tasks using a cell phone.

You have just purchased a new cell phone and want to personalize it. Follow the instructions for each task
and then perform the task as you would if you were actually doing this task for yourself.

Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations, and
reactions.

Do you have any questions?
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Scenario in Morae Configuration

@ Recorder > Modify Study Details button > Description tab

Enter the scenario into the Study instructions field.

Study Details @

Description | Task Definitions | Marker Definitions | Survey Definitions |

Enter a name, description and participant instructions for the study.

Study name: ’ Hardware or Mabile Device Study

Study description:  [jce For testing a hardware device (cell phone, handheld, etc.) You ca

use up ko two cameras, Point the primary camera at the hardware
device, and the picture-in-picture camera at the participant.

Study instructions: ‘You will perform up to 4 different tasks using a cell phone.
You have just purchased a new cell phone and want to
personalize it. Follow the instructions for each task and then
perform the task as you would if you were actually doing this
task for yourself.

Please talk out loud while you work, and keep a running dialog
of your thoughts, actions, expectations, and reactions.

Do you have any guestions?

B ul[= == AlE Wl

’ Avrial v J

[ OK ][ Cancel ][ Help ]

Morae Scenario Tips

B  Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test
Protocol Document).

B To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See
AutoPilot in the Morae Recorder help for more information.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Description >
Study Instructions.
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3. Define Tasks

The tasks should relate to real-life actions that fit the scenario. For more on how to create a scenario, see
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center.

For example, i f we use t he justpuechaped anew cekpha@ne andwantto A You ha:
personalizeit, 6 our f i changethe engthine.i s t o

Tasks in Morae Configuration

Recorder > Modify Study Details button > Task Definitions tab

For each task, enter a Name, Description, and Instructions for the participant.

Study Details

Desctiption | Task Definitions iMarker Definitions | Survey Definitions |

Define tasks to log during sessions.

MName Description
Change the ringtone. ]
Task 2 Discuss how would transfer contacts., C
Task 3 Transfer contacts to new phone. [
Task 4 P Find and buy applications with phone.
Al : o
T Task names, descriptions, and scores are

available to the task logger in Recorder or
Observer and in the task information in

Success score
Success score applies to all

Definition Scale | £ Add
Completed with ease 0 :
Completed with difficulty 1 7 Edit
Failed to complete 2

A Remove

[V]start Scali  Success score is a standard metric used to
analyze usability tests. You can create a task

success score graph in Manager to automatically

calculate and visually display the completion rate.

= Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test
Protocol Document) on the Task pages. Each task should be on a separate page so the participant
can only see one task at a time.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks.
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4. Define Markers

After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure
out what kinds of actions you want to define marker for because, by flagging important points during recording,
you can save time when you later analyze the results.

For example, mark:

Participant actions

Participant comments and questions

Participant frustration

Areas where a participant gets stuck

Application or web site design issues

Observations about how the participant performs a task

Interesting comments or actions to include in a highlight video

Moments when participantés access Help, want to cont

¥ ¥V ¥V ¥ V¥V ¥ VW

You can also add notes to provide additional details for each marker. All the markers and notes are
synchronized with the video and saved in the recording of each test session.

Morae also includes the ability to score markers, for example 0 (severe) to 2( minor). Manager can
automatically calculate the average severity of the errors.

Markers in Morae Configuration

& Recorder > Modify Study Details button > Marker Definitions tab

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color.
Each study configuration template includes a default set of markers. The Hardware or Mobile Device Study
template includes the following markers:

L
. QT Quote/comment X - Error

’ ’ O- Observation

H 1 User needs help

P - Participant prompted 0 V1 Video clip

Use the provided default markers, modify the markers, or create new markers that match the goals of your
study or identify specific things you want observers to watch for during a session.

Morae Marker Tips

B There is no correct number of markers. The object of logging markers during a test is to make it easier to
analyze the test results.

= If you have specific things you want to look for in a test, create a marker for that action, problem, etc.

B+ Later when you analyze your sessions in Manager, markers help you sift through data and focus on what
you want to analyze. For example, viewing all the Help requested markers may reveal an error where
people are really struggling.

#  When you are ready to create video clips or a presentation for stakeholders, you save time by quickly
going to the moments during the session that you marked to include in the highlight video.
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For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers.

5. Define Surveys

With surveys, you can collect information directly from the participants.

To collect a participantés s ur uestionswvesbslly andtype the respomses ¢ a n
into the survey, have the participant take the survey on the computer running Recorder, or use the Morae
Add-In for Word to print the surveys for the participant to fill in on paper.

After you import recordings into Manager, you can view and compare responses, create graphs based on the
surveys, and export results, including any freeform answers.

Morae can open multiple surveys to participants during a session. For example, use a survey before the test,
after each task, and after the test.

The template study configuration includes surveys. Use or edit the surveys provided or create your own
surveys.

Surveys in Morae Configuration

Recorder > Modify Study Details button > Survey Definitions tab

Create and associate surveys with session events, such as the end of a task.

Study Details

Description | Task Defintions | Marker Definkions | Survey Definkions

Define surveys for this study. Associate surveys with session events, such as the end of a task,

Assocwto With % add N :
Task 2 Corrdetvon Survey End of Tasi 2 Edit
Task 3 Completion Survey  End of Task 3
Task 4 Comgletion Survey  End of Task 4 Copy 41
Task S Completion Survey  End of TaskS _— -

sus End of vecovﬁ' N
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Survey detals
Survey name: Participant instructions:
Demographic Survey Please answer the Folowing quastion:
Associste with:
Begineeng of recordng v
Morae indudes Survey quastions
System Usability
Scale (SUS) standard h
satisfaction questions © Custom questions
that you can use once Question Type
per study recording. Please indicate your gender: Select one 2
' ! Plaase indicate your age range: Sedect one
Please rate your experience with the Internet Scale
How many hours 3 week do vou spend on the Inbernes ab work? Sedact 0



Morae Survey Tips

B Associate a survey with the beginning of recording, end of recording, or the end of each task.
B By associating asurveywithasessi on event, it is Alinkedo to that ev
Morae readies the survey associated with the current session event.

B  Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test
Protocol Document).
B  The System Usability Scale (SUS) is freely available for use in usability assessment and has been used

for a variety of research projects; the only prerequisite for its use is that any published report must
acknowledge the source of the measure. If you use the SUS, add the following to your report:

ASUS was developed as part of the wusability
devel opment at Digital Equi pment Co Ltd., Read

engi nee
i ng,

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys.

6. Save Study Details

L] File > Save Study Configuration or click the Save Configuration icon.

Study Details must be the same for all recordings in a study and include the items you have just defined:

#  Study name, description, and instructions
B  Tasks definitions and instructions

B Marker definitions and instructions

B  Survey definitions and associations

By saving the study configuration, and reusing that configuration, all recordings in a study have the same
configuration and can be imported into the same study in Manager.

7. Configure Recording Details

Recording Details included in Morae study configurations define how to record the session, including the
following:

# File saving and processing options

Video sources

What data to capture

Who logs tasks

How to start and end test recordings

¥y ¥V ¥V V¥
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Recording Details in Morae Configuration

&8 Recorder > Recording Details button

The Recording Details of the template study configuration allow you to immediately conduct a recording.
The Recording Details for the Hardware or Mobile Device Study template include:

#  Prompt for file saving details when recording stops

Record from a camera and include a Picture-in-Picture video from a second camera
Log tasks with the computer running Recorder

Start and stop recordings manually with Recorder

Allow Observers

¥y ¥V ¥V V¥

Morae Recording Details Tips

# Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected
sources are correct before recording.

# If you change any Recording Details settings, the rest of the settings update to provide a valid or
recommended configuration, if needed.

# Recording Details are saved as part of the study configuration. While the Study Details must be the same
for all recordings in a study, the Recording Details can vary in each recording.

For more information, in the Morae Recorder Help, see Define Recording Details.

8. Complete Test Set Up

Study configuration is now complete. Here are the final things to do before you start testing.

# Create Test Protocol
# Finalize Morae Recorder Setup

Create Test Protocol

The test protocol is a document of everything needed for a test. There is an example protocol document in
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.

B Test Session Setup Checklist

Release Form

Facilitator Script

Participant Instructions and Surveys
Assemble Participant Paperwork (Optional)
Email Invitations for Observers

¥V ¥V ¥ ¥V V¥
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Test Session Setup Checklist

Verify the test setup is the same at the beginning of each test. A test setup checklist makes it easier to go
from one test to the next as quickly as possible and make sure you do not miss anything.

Make a list of all the things you need to do between tests and include it in test protocol document, such as:

v

Reset the mobile device to the default settings.

B Clear the test area of any open documents, written notes, etc.
B Prepare participant forms (release form, surveys, etc.)

B Verify the cameras, camera angles, and lighting.

Release Form

A release form gives permission to record thetest. Mor ae r ecor ds drastenspiththe i ci pant 6
hardware or mobile device with video and audio.

If permission to record is denied, you may still conduct the test and take notes to use in reporting results, but
you must not record the test session.

If the contents of your test require the participant to keep session and product information confidential, include
a non-disclosure agreement to your form.

The example test protocol includes a sample release form that includes a non-disclosure agreement.

Facilitator Script

The facilitator script helps to explain the test session to the participant. The facilitator reads through the script
at the beginning of each test session to ensure the participant understands what to expect during the test.

Participant Instructions and Surveys

Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the
study configuration in the add-in and drag the study and task instructions along with the surveys into the
protocol.

'Movoe Task Pane v X |

= |
Morse Project ? |
Examgle Project v | EBrowse
S i
!

1. Please indicate your gender:
( ) Female
[ ) Male

2.Please indicate your age range:
()1825
{ }26-35
{ }36-50
{ )51-65 ;
[ )65+ . \

3. Please rate your experience with the Internet
Very New 1 2 3 4 s Very Expenenced Th1

4. How many hours a week do you spend on the Internet at work?

For more information, click the help button in the Morae Add-In for Word.
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Assemble Participant Paperwork (Optional)
Once you finish the protocol document, you need to assemble any paperwork needed for a test.

If you are printing paperwork, each participant needs a copy of the following:

v

Release form

B  Background questionnaire

B Scenario/session instructions
#  Tasks

For the facilitator, print a copy of the protocol. In addition to the participant items listed above, the facilitator
protocol includes the following:

Title page

Session setup checklist

Participant paperwork coversheet

Facilitator script

Task success paths (the best way or ways to complete a task)

List of debrief questions (follow up questions for the end of the test)

¥V ¥ V¥ ¥V VWV

See the example test protocol in Appendix B: Test Protocol Document for an example of complete protocol.

Email Invitations for Observers

Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people
that observe the test can connect to the session, send an email to each observer with the following
information:

#  Name of test

B+  Date of test

B  Time of test

B IP address or name of Recorder computer

= You may also want to include a list of the test tasks and markers to let the observers understand what
they should watch for during the test.

Finalize Morae Recorder Setup

Prior to a Morae test, complete the following tasks:

B Complete the Pre-recording Checklist
= Run aPilot Test Before Recording
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Complete the Pre-recording Checklist

The following checklist describes critical points that reduce the technical issues you may encounter and
improve Mo r a evérall performance.

Step ‘ Description

Verify the system Verify your system meets the recommended specifications to get the most efficient
requirements performance from Morae. For more information, see Morae System Requirements
in the Morae Recorder Help.

Verify you have Recording file sizes may be approximately 107 15 MB per minute, but the actual size
enough hard drive varies depending on many factors. You should have extra space available for the
space best performance during recording.

As a general rule, maintain 57 10 GB of extra hard drive space as a buffer beyond
what your Morae recording files use.

A’ We recommend initially saving your recordings to a local hard drive to eliminate
the chance of data loss that can occur when saving over a network or to an
external device. After the file is saved, you can copy the recording file to an
external device.

Test your setup and | Test your setup before the actual recording session to resolve any possible
scenario complications (such as firewalls blocking Observer(s) from connecting, etc.).

We recommend running a pilot recording
start and stop options and to verify Observer(s) can connect. For more information,
see Run a Pilot Test Before Recording.

A’ In addition, use the Test Recording option in Recorder to create a 15 second
recording to verify the screen, camera, and audio streams are being recorded

properly.
Verify Network If Observer and Recorder are on the same Intranet, you do not need to disable
Settings firewalls.

If they are not, verify that you either disabled any firewalls running on the Recorder
or configured the firewalls to open the communication ports. See your network
administrator for assistance.

There are no firewall adjustments necessary on the Observer side.

Open the study Open the saved study configuration in Recorder.
configuration in
Recorder
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Run a Pilot Test Before Recording

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot
recording helps you work out any network connectivity issues and test your automated start and stop options,
if applicable.

Follow these steps to run a pilot test:

Step ‘ Notes

1. Open a study configuration. | In Recorder, open the study configuration (.mrcfg) for this

study.

2. Start Recorder. Click the Start button to start Recorder manually.
Connect Observers to Connect one or more Observers during the pilot test.
Recorder. Verify that you can successfully connect each to

Recorder.
4. Complete a test task. Run through one of the tasks. To test the logging

functionality of Observer, have a team member practice
setting markers while you complete the task.

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button
in Recorder or use the keyboard shortcut <Ctrl + Alt +
Shift + F9>.
6. Import the recording and Save the test recording file and import it into a project in
run a search. Manager. In Manager, verify the audio and video recorded

correctly. Use the Search to verify markers were captured.
See Analyze and Present Findings for more information
on how to do this.
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Record and Log Test Sessions

In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae
Recorder and Observer. Included in the section are the following:

# Log Tasks on Recorder

Observers and Logging

Start and Stop the Recording

Log the Sessions

Send the Surveys

Save the Recording

¥V ¥V V¥ ¥VV¥

Log Tasks on Recorder

When you record from one or two cameras with Recorder, you can log tasks and notes right on the computer
running Recorder. This is the default task logger setting for camera only recordings.

Observers and Logging

Morae Observer connects to Recorder over a networkand di spl ays the full participa
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores,
and text notes that are sent back to the Recorder and saved with the recording file.

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically
create graphs, calculate marker scores, and more.

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not
see the participant interaction until recording begins.

Benefits of Observer

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the
following benefits:

B+  Stakeholders can connect to watch live sessions without the need be in the room with the participant or
an observation room. With Observer, stakeholders can connect from anywhere on the network.
#  Anyone logged into an Observer computer can add markers during recording complete with text notes.

P Morae automatically collects and compiles everyonebs
notes logged by all Observers.

B  Observer automatically saves and indexes the markers and tasks with the accompanying video and audio
streams.

B  You can save a copy of the camera video and audio streams as a WMV file for immediate playback or to
share with stakeholders.

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to
Recorder.
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Start and Stop the Recording

The default way to start and stop recordings is to manually start and stop Recorder using the following
buttons:

Start Stop

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your
equipment and participant set up.

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start
Settings and Define Recording Details > Recording Stop Settings.

Log the Sessions

Once recording starts, the facilitator prompts the participant to begin the test.

The person working on the computer running Recorder along with each person using Observer can log
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder
is designated as the task logger logs tasks and task scores.

With both Recorder and Observer, you can save a copy of your markers and notes. Observers can also save
a copy of the recording as a WMV file for immediate viewing.

—_— —_ cpmn S ey B R e S AN .. DY S LRt et ., o
.\_/'. -“.-4’ v';,v-'uf-/.. _’_;4"__/_~ Yt —_— L v =" "-w" LU L ROV T o S
Survey: Survey v | Send Survey | =
Note Marker T Score Task Time
(D rasemss) | @ erdraskinsn | e _
L ) Task wes successfl Task | 00028
Logas: |Task3 v & Teskwes sxcenf Task 1 00042
& v Task 3 00048
00 . O 1 . 4 1 iﬂj @ e zaid he this was very confusing, Q-Quotajcomment Tack 3 0:01:41
2 3 © Covel 0['!&"55‘%49?!'5!2'1. “"-Um reeds help Task 3 ol
|
Recordin time = 000030 Task: Task 3 Task ogger: TH any Q Connection u Recordeg

At the end of a session, the tasks and task scores are saved with the recording. You can view the
synchronized video, audio, and notes for each marker later when you import the recording into Manager.

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager.
There should be no need to review entire recordings
features to quickly analyze the recordings.

The components used when logging in Recorder and Observer are:
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Marker Definitions
Click a Marker Type to
:“"“‘ enter a marker. (Optional)

[ Marker Defwstins (read u'l.y) ] Viemng Window

Tye | belriion V iew session main

®c e camera video and PiP
g video, ifincluded.

@ Loy mesten
&0 boarwwen

® ¢ Patcpwt provgted
&y weedp

urvey: Survey (in progress|
{0 Pusie (Ak4+P) ] l. wru‘mu)J Py L Yiwter Trpe Seare 1:1 J,:w
Log a5 |Taska v @ ¥ ths produtt Qe comment Task 1 00602
v Task 1 00822
x = E‘ Rastart ". Tak ¢ D0&2%
00-01-18 Lw Task 4 0On08

Log markers and take notes. Log
[Recordog e = 00.07:45 task start and end, if applicable. iy Comectin ) Pacaedng
p Y] ¥

For more information, in Morae Observer Help, see Log a Session.

Send the Surveys

Open surveys on the computer running Recorder anytime during the session. When the surveys open, you
can ask the participants the questions and fill out the surveys, let the participant fill out the surveys on the
computer running Recorder, or use the Morae Add-In for Word to print the surveys for the participant to fill in
on paper.

The person logging on the computer running Recorder and all Observers can access and deliver surveys.
# In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>.

In Recorder or Observer, select and open surveys from the log.

Survey: Task 2 Completion Survey v |  Recall

© |

Marker T

Task 3 Completion Survey i \g
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Save the Recording

By default, when recording stops, you are prompted for file details. Enter a name and description for the
recording. If you want to start another recording right away, in Recording Details, choose to defer the
processing of the recording. You can later batch process recordings.

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details >
Processing.

v You cannot save a recording without a name. You can lose the data from a recording if the test
participant, or anyone else, closes the dialog prompting for these details after the recording stops.

Analyze and Present Findings

In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and
create presentation materials for the test findings, including:

1. Import Recordings
2. Edit Recordings

3. Analyze Recordings

4. Graph
5. Create Highlight Clips

6. Create a Report

1. Import Recordings

To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the
recordings and studies in Manager.

You can have multiple studies in a single project. The following are possible reasons to have multiple studies
in a single Morae project:

B You conduct the same test on different iterations of a product.

#  You conduct various tests on the same product.

B You want to separate your studies by the experience level of participants.

You can import a single recording into multiple projects. When you import a recording into a project, the
original recording is not touched. A copy of the recording in imported into the project. Any changes you make
to this copy do not affect the original recording.

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf)
into a project.

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create
and Modify a Project > Create a New Project.
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2. Edit Recordings

View and edit the imported recordings in the Analyze Tab. In Manager:

# Review the main camera video automatically synchronized with the Picture-in-Picture video and audio.
B  Create additional or edit the logged tasks, markers, notes, and scores.

B Search across recordings in a study for specific markers.

B  View and edit survey answers.

For information, in the Morae Manager Help, see Analyze.

3. Analyze Recordings

For information on what kinds of things to look for in the recordings, see How to Retrieve Your Key
Measures from Morae.

Managerd Search allows you to quickly create custom searches to look for markers and tasks.

You can use the pre-defined search profiles, define a new search, or create and save your own search
profiles.

Search for:
[7] screen Text
[[] Window/Dialeg Events
Markars (Specfic markers of mark... L1000 o
] mMouse Clcks ]§
[ Uservue Chat ¥
[ keystrokes
[C] web Page Changes

In 3l applications

Search for markers that meet the Following criteria,

\ k O All markers
(%) Speciic markers
[V1Marker type
[J - End rask A
H - User nesds help
[[] ©- Observation

[[] P - Particpant prompted
[[] Q- Quotefcomment

[[] 5-start task

[ v-video clp v

< >

[V]Marker score

[] score not set | Select Al
Ml severe (0

BT
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06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc

Click to change the search. J

Click to save the current search as
aprofile

Search Re alts

Modfy Search. .. Searching for: Markers

0:02:02.08 Participant 2
0:03:12.00 Participant 1
0:03:28.15 Partiopant 3
0:03:28.15 Participant 3
| 10:04:47.32 Participant 2
| |0:05:26.14  Participant 1
| 0:07:32.06 Partiopant 3

A

|
|
|
i 7 / Elapsed Recording
|
\
|

<

K

Task Event
Marker

Task2  Marker
Task2  Marker
Task2  Marker
Marker

Task3  Marker
Task4  Marker

Results include all occurances
Total Every from all recordings in the study.

(~Search profile -
| 'Custom search

Details
H (User neads help)
H {(User needs help)
H (User needs help)
H (User needs help)
H (User neads help)
H (User needs help)
H {User neads help)

Notes

Issues with the phone locki... 2 - Minor

Requests help from facilitat
Locked out of phone

Runs into trouble with the ...

Can't figure out the setting

Wants to call customer sup...
Can't figure out menus. As...

L Selected Duration: Not applicable

Yl @)

,vew,

Score

ver 1 = Medium

0 - Severe
Score not set
o 2 = Minor

1 - Medium
I.Med.m

For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings.

4. Graph Data, Tasks, Markers, and Surveys

Instead of manually calculating data and building graphs, Morae creates graphs to help you share results
faster, without manual calculations and scrubbing of data.

Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight
videos. Highlight videos can be more powerful with graphs included to support the video clips.

Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format
(CIF) standard i effectiveness, efficiency, and satisfaction:

B Measure effectiveness with error rate and completion rate graphs

B+ Measure efficiency with a time on task graph

B Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to
participants at the end of the recording
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Example Uses of Graphs

Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why
you might want to use these graphs.

SUS Survey
Graph

oS8 ‘-0‘7
S o=
Survey SUS Survey
Analysis Calculation

Use this graph to measure satisfaction from a
System Usability Scale (SUS) survey.

SUS scores can range from 0 (very little
satisfaction) to 100 (very high satisfaction).

Time on Task
Graph

Task Analysis

Use this graph to measure efficiency.

Efficiency is usually measured by determining how
quickly participants are able to complete scenarios
or tasks.

Participants may be able to successfully complete
an activity, but they take a long time.

Task Score
Graph

Task Analysis

Task Score

Use this graph to measure effectiveness by
reviewing the completion rates for tasks.
Effectiveness is a way of trying to understand better
how successfully users will be able to use a site or
software. This is usually measured by determining
how many scenarios or tasks participants are able
to complete.

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph >
Graph Analysis Examples.
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5. Create Highlight Clips

When you are ready to organize the results of your analysis into a highlight video for presentation, select
Managerd Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort clips and graphs and
assemble them into a video presentation.

In the Present tab, assemble the important video clips, graphs and tasks into a highlight video to share with

stakeholders. Include just the participantd s screen and audi o in theinBidtugeh!| i ght
(PIP) window showing the parTheéhighlighavideoican bé prodiucedlin A€l WMVe s si on
or MPEG-4 format.
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